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INTRODUCTION 
 

Heat exchangers are devices designed to exchange heat between the heating and 

heating media. The latter is commonly called heat carriers. 

The need to transfer heat from one coolant to another arises in many branches of 

technology: energy, chemical, metallurgical, oil, food and other industries. 

In the boiler unit, the heat released during fuel combustion is transferred to water 

and steam, i.e. the boiler unit is a set of heat exchangers. In the nuclear power plant, 

the heat released by the nuclear reactor is perceived as the primary coolant, which 

itself becomes radioactive. The engine uses a secondary heat carrier, which receives 

heat from the primary heat exchanger. The process of regeneration in the gas turbine 

plant is carried out by transferring heat in the heat exchanger from the exhausted 

combustion products to the compressed air. 

The wide distribution of heat exchangers causes a variety of their design. 

Thermal processes occurring in heat exchangers can be very diverse: heating, 

cooling, evaporation, boiling, condensation, melting, solidification and more complex 

processes which are a combination of these. In the process of heat exchange, several 

heat carriers can participate: heat from one of them can be transferred to several and 

from several to one.  
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Chapterr 1. PREPARATION OF THE CALCULATION MODEL  

1.1 Shell modelling using ANSYS Workbench 
 

The calculation is based on the software shell ANSYS Workbench 14.5. 

First you need to run ANSYS Workbench: Start → All Programs →ANSYS 

14.5→Workbench 14.5. The working window of the program opens (Figure 2.1). 

As a project, you must select Fluid Flow (Fluent) (Figure 1.1). 

 
Figure 1.1 – Appearance of the Workbench work window and calculation charts 

for Fluid Flow (Fluent)  

To import a geometric model, go to the Geometry module. 

The program prompts you to select a unit of measure. You must select millimeters 

(Figure 1.2). 

After that, the geometrical model of the flow part of the heat generator is loaded 

(File → Import External Geometry File). The Import icon appears in the tree. Click 
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on it and select Generate. After that, the model should be visualized in the Graphics 

window (Figure 1.3). 

 
Figure 1.3 – Appearance of the heat exchanger section 

The design model is a section of the heat exchanger. The heat exchanger consists 

of tubes with fins, inside of which water flows. Outside, the finned surface of the 

pipes is blown with hot air, the heat of which is transferred through the steel pipe to 

cold water. The calculation model must be divided into 3 main parts: gas path, tube 

and water. To do this, open the Parts section in the build tree, select the body and 

click the right button in the resulting window to select Rename (Figure 1.4). 
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Figure 1.4 – Renaming the main parts of the model  

After importing the original model by default, all 3 main parts are solid bodies. 

For gas (gas) and water (water) tracts, it is necessary to change the body type from 

solid to liquid (Figure 1.5). In order for the Details of Body menu to appear, you must 

select the body in the Parts tab as in the previous step. 

 
Figure 1.5 – Changing the body type 

After that, you can close the Design Modeler screen. 
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1.2 Finite Element Mesh Construction 

The workpiece mesh is built in the Meshing module. The heat exchanger model 

will be loaded automatically (Figure 1.6).  

 
Figure 1.6 – The working window of the Meshing module and the appearance of 

the loaded geometric model of the heat exchanger section. 

For a correct calculation, the grid at the finned surface, the pipe itself and the 

water path must be made smaller. To do this, in the build tree, select the Mesh tab 

and press the right button. In the window that appears, select Insert → Sizing (Figure 

1.7). 

 
Figure 1.7 – Sizing grid size adjustment menu  
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The size of the element (Element Size) on the surface of the edges that come into 

contact with the gas and the body of the pipe itself is 0.5 mm. The size of the element 

for the water cavity – 1 mm. 

After that, right click on Mesh and select Update. The program will begin the 

process of dividing the volumes by a finite element mesh. After its termination the 

model will look as follows (Figure 1.8):

 
Figure 1.8 – Appearance of the mesh  

Now we need to designate the surfaces for the boundary conditions for the entry 

and exit of water and gas. Also, to further adjust the process of transferring heat from 

gas to water through the pipe, it is necessary to separately identify the contact 

surfaces of the gas and finned tube, the inner surface of the pipe and water (4 total 

surfaces). To do this, select the desired surface, press the PCM and select the Named 

Selection item. A dialog box will open (Figure 1.9). The direction of movement of 

the water is controlled by the X axis, the direction of the gas flow with the Y axis. 

The result of the selection of the surface selection is shown in Figure 1.10. All 

surfaces are indicated in the tree of construction.  
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Figure 1.9 – Appearance of the surface name selection window 

 
Figure 1.10 – Appearance of the Surface Name Selection Window 

After that, the Meshing module can be closed. 
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Chapter 2. MODELLING HEAT EXCHANGERS  

2.1 Running the ANSYS Fluent program and its features   

Further actions with the calculation model, which are performed in the ANSYS 

Fluent program, are the setting of boundary conditions, adjustment of the solver 

parameters, execution of calculations and processing of the results. 

To start the program, you need to enter the module Setup in the ANSYS 

Workbench. The dialog window for running ANSYS Fluent will open (Figure 2.1). 

 
Figure 2.1 – The menu for starting the program ANSYS Fluent (Fluent Launcher) 

In the case under consideration, the problem is three-dimensional. After selecting, 

press the OK button. As a result, the ANSYS Fluent working window appears on the 

computer screen (Figure 2.2). 
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Figure 2.2 – ANSYS Fluent working window 

The program window is quite simple and consists of three main parts: 

- the main menu, through which access to all commands and menus of the 

program; 

- the message window where the command line is located and the results of the 

commands execution are displayed; 

- Graphical windows in which the results of calculations and constructions are 

displayed. 

Downloading a Grid File 

Since the ANSYS Fluent is started from the Workbench software environment, 

the attached grid will be loaded automatically. 

Checking the finite element mesh for errors 

Checking the calculated grid for errors is performed using the command: 

GM: Mesh → Check 
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After its launch, the program will begin to check the finite element mesh (Figure 

2.3), and full information about the finite element mesh will appear in the message 

window. If an error is found, a corresponding message will be issued. In this case, 

you need to return to the Meshing program, find the error and fix it.

 
Figure 2.3 – Mesh Display 

Scaling of finite element mesh 

Geometric dimensions in ANSYS Fluent must be specified in meters, so in case 

of creating a model in millimeters, it is necessary to scale it. In our case, this step is 

not needed, because when you move a geometric model in ANSYS Design Modeler, 

the scaling is done automatically. 

View Finite Element Grid 

You can view the finite element mesh of the loaded model using the command: 

MM: Display → Mesh 

In the appeared Mesh Display menu (Figure 2.14) in the Surfaces window it is 

required to select all surfaces forming the grid model. It should be noted that the 

names in the list coincide with the names of the surfaces specified in Meshing. To 

view the selected grid elements, click the Display button. 
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Figure 2.4 – Mesh Display 

As a result of the command, a graphic window will appear in which the calculated 

grid or selected model elements will be displayed. 

If you deselect the default in the Surfaces window, you can see only the outline of 

the model in the window, without a calculated grid. 

2.2 Setting up Calculation Parameters 

Setting the Solver Options 

As the first action in describing the computational model, it is necessary to choose 

a solver that will be used to solve the problem, as well as to determine the stationarity 

or nonstationary of the problem. This selection is made in the Solver menu: 

MM: Define 

In the Solver menu (Figure 2.5), you need to pay attention to the following points. 

The ANSYS Fluent program allows the use of two decision algorithms: Pressure 

Based or Density Based. The first of these was originally developed for low-speed 

flows, but was subsequently modified and extended to other currents. The setup 

algorithm was designed to calculate high-speed trans- and supersonic flows. To solve 

the problem under consideration it is expedient to choose Pressure Based. 
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Figure 2.5 – The solver setting menu (Solver) 

In the Time field, it is selected whether the solution is stationary Steady or non-

stationary Transient. That is, whether the flow parameters will depend on the time or 

not. The problem under consideration is three-dimensional stationary. In addition, in 

this problem, gravity must be taken into account. To do this, select the Gravity item 

and specify the value of the acceleration of free fall equal to -9.81 m / s2. 

Choice of the model of turbulence 

The flow of a liquid is characterized by the presence of turbulence - a disordered 

motion of the vortex masses. In this case, transverse components are superimposed 

on the main velocity direction, causing strong mixing of the liquid / gas. When 

studying the flow in the heat generator channel, it is advisable to use the k-epsilon 
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turbulence model, since it allows obtaining solutions with acceptable accuracy, and 

for this model it converges well (Figure 2.6). 

MM: Define → Models → Viscous. 

 
Figure 2.6 – Adjusting the turbulence parameters (Viscous) 

Connecting the Energy Equation 

When solving this problem, heat exchange and heat transfer must be taken into 

account. To do this, you need to connect the energy equation to the solution using the 

command: 

Define → Models → Energy ... 
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In the window that appears, tick the Energy Equation box and click OK (Figure 

2.7). 

 
Figure 2.7 – Energy equation inclusion menu (Energy) 

Setting the properties of the working fluid and reference pressure 

You can set the properties of the working fluid in the Materials menu 

(Figure 2.8), which is called by the command: 

MМ: Define→ Materials 

 
Figure 2.8 – Materials menu (Materials) 

In this problem, water and air are used as a working fluid. Air is set by default. In 

order to add water as working fluid, in the Materials menu it is necessary to press the 

Fluent Data Bases button, and then select the necessary water-liquid material from 

the database in the appeared Fluent Fluid Materials list. 
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The peculiarity of the ANSYS Fluent program is that the pressure received and 

set in the calculation is redundant. That is, in order to obtain the true value of 

pressure, it is necessary to add to it the so-called "reference pressure". By default, its 

quality is normal atmospheric pressure - 101325 Pa. If 0 is taken as the reference 

pressure, the calculation results and the initial data will be set in absolute values. You 

can change the value of "reference pressure" in the menu (Figure 2.9), which appears 

as a result of the command: 

MM: Define→ Operating Conditions 

 
Figure 2.9 – Operating Conditions 

To simplify the processing of the results in the problem being solved, it is 

advisable to take "reference pressure" equal to zero, and enter its value in the field of 

the operating pressure. 

 

2.3 Setting Boundary Conditions 

The menu for setting boundary conditions (Figure 2.10) is called by the 

command: 

MM: Define→ Boundary Conditions 
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The Zone field contains a list of all the boundary conditions defined in Meshing. 

If you select the name of one of them, for example, massflow_inlet_water, then the 

type of the boundary condition will be specified in the Type window. If necessary, 

the type of boundary conditions can be changed in this window. To start setting 

boundary conditions, you need to select the required boundary condition in the Zone 

window, make sure that the type of the boundary condition is specified in the Type 

window, then click Edit ... 

 
Figure 2.10 – Boundary Conditions 

The name and type of the boundary condition are presented in Table 1. 

Table 1. – Boundary conditions 

№ Boundary condition name Boundary condition type 

1 massflow_inlet_gas pressure-inlet 
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2 massflow_inlet_water mass-flow-inlet 

3 pressure_outlet_gas pressure- outlet 

4 pressure_outlet_water pressure- outlet 

5 interface_gas_to_tube interface 

6 interface_tube_to_gas interface 

7 interface_tube_to_water interface 

8 interface_water_to_tube interface 

 

After that, the following actions are performed: 

The parameters for the input boundary condition massflow_inlet_gas are set, in 

accordance with Figure 2.11: 

 
Figure 2.11 – Setting the boundary conditions for the inlet section of the gas path 

(massflow_inlet_gas) 

The gas temperature is set in the Thermal tab and is 587 ⁰K (Figure 2.12). 
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Figure 2.12 – Setting the gas temperature at the inlet 

The parameters for the output boundary condition pressure_outlet_gas are set in 

accordance with Figure 2.13. 

 
Figure 2.13 – Adjustment of the boundary conditions for the outlet section of the 

gas path (pressure_outlet_gas) 
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The parameters for the input boundary condition massflow_inlet_water are set in 

accordance with Figure 2.14. 

 
Figure 2.14 – Setting the boundary conditions for the input section of the water 

path (massflow_inlet_water) 

The gas temperature is set in the Thermal tab and is 293 ⁰K. 

 

The parameters for the input boundary condition pressure_outlet_water are set in 

accordance with Figure 2.15. 
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Figure 2.15 – Setting of the boundary conditions for the waterway outlet section 

(pressure_outlet_water) 

Adjusting permeability zones between individual grid areas 

ANSYS version 14.5 automatically creates permeability zones, after which they 

are displayed in the Mesh Interfaces window (Figure 2.16): 

 
Figure 2.16 – Display of created surfaces 
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If you are working in an earlier version, these zones must be created. A total of 2 

permeability zones are created: from the outlet branch to the cochlea and from the 

cochlea to the tube. 

To do this, click Create / Edit in the Mesh Interfaces window. To create a zone 

of permeability (Figure 2.17), in the Mesh interface, you need to specify gastotube, 

select Interface_gas_to_tube as Interface Zone 1, interface_tube_to_ gas as an 

Interface Zone 1, and then click OK. Similarly,  tubetowater is created, as Interface 

Zone 1 - interface_tube_to_water, as Interface Zone 2 - interface_ water_to_tube. 

 
Figure 2.17 – Setting up the created permeability zones 

Setting up the process for solving the problem 

Set calculation parameters 

The menu for setting calculation parameters is accessed using the command: 

MM: Solve → Methods 

As a result, the Solution Methods menu appears on the screen (Figure 2.18). 
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Figure 2.18 – Configuring calculation parameters (Solution Methods) 

This menu consists of three main groups of configurable parameters: 

Spatial Discretization; 

Pressure-Velocity Coupling; 

Transient Formulation. 

In the Spatial Discretization zone, the discretization schemes of the corresponding 

equations are determined, that is, the algorithm for constructing a discrete analog of 

the differential equation at the node of the finite element grid is described. 

To obtain exact solutions, it is necessary to use second and higher order sampling. 

However, at the first iterations such a solution is unstable. 

Therefore, the first few dozen iterations should be carried out in the first order 

order (First Order), then increase it. 
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In the Pressure-Velocity Coupling zone, an algorithm for solving the equation of 

motion and continuity coupling is chosen to correctly determine the pressure and 

velocity fields. To solve the flow problems in interblade channels, it is advisable to 

choose the Coupled algorithm (it is similar to the splitting algorithm). 

Set initial values of calculation parameters (initialization of the calculation 

process). 

When solving problems of gas dynamics by numerical methods, it is necessary to 

establish the initial values of the parameters in the computational domain before 

starting the solution. The initial conditions setup menu (Figure 2.19) is called by the 

command: 

MM: Solve→ Solution Initialization 

 
Figure 2.19 – Initialization of the process of calculation (Solution Initialization) 

In the field of this menu, Compute From, you must select an input border. As a 

result, the recommended values of the initial parameters will be calculated from the 

input boundary conditions. To accept them, click Initialize. 
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Configuring the display of the solution process. 

In order to display discrepancies in the calculation process, and also to set a 

criterion for stopping the solution, it is necessary to call up the Residual Monitors 

menu (Figure 2.20) with the command: 

MM: Solve → Monitors→ Residual Monitors 

 
Figure 2.20 – Configuring the display of the solution process (Residual Monitors) 

In the Option field, check the Plot and Print boxes. This will cause the residuals 

for all equations to be printed in the Print message window and displayed as graphs in 

the Plot graphics window. 

In the fields of Residual, above each other, all solved equations are listed, and 

opposite to each of them, limiting discrepancies are established. The problem is 

considered solved when the residuals for all equations are less than the set values. In 

this case, the calculation process will be automatically stopped. It is believed that to 

obtain an exact solution it is sufficient to achieve the 10-3 residuals for all equations. 

To save the calculation model and all the settings made by the solver, you need to call 

the command: 

MM: File → Save Project. 

Run the calculation for 1000 iterations using the following actions (Figure 2.21): 

MM: Solve → Run Calculation 
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Figure 2.21 – Running the Calculation Process 

If the condition of convergence is reached, then the process of counting will stop 

itself and the message "solution is converged" appears. If a given number of iterations 

is not enough to obtain a solution, then the decision process can be continued. The 

solution may not converge in this range of iterations. Then it is necessary to increase 

their number to 10,000. For faster convergence, it is possible to reduce the relaxation 

factors to 0.1. 

2.4 Results Processing  

At this stage, it is necessary to display the static pressure contours in the 

investigated places. To view the parameters distribution fields, run the following 

command: 

MM: Display → Contours 

As a result, the Contours menu appears (Figure 2.22). To distribute the parameters 

displayed in the form of fields, you must tick the Filled box. Otherwise, the parameter 

distributions will be displayed as isolines. The parameter whose change you want to 
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display is selected in the Contours of field. It consists of two drop-down lists. In the 

upper group, the group to which the desired parameter belongs (for example, 

pressure) is selected. The lower list specifies which group parameter is to be 

determined (for example, static pressure). This is a typical and often used procedure 

for selecting the displayed parameter in the ANSYS Fluent program. Similarly, the 

parameter is determined when determining the mean integration values. The Surfaces 

field defines the surfaces on which the parameter distribution fields are constructed. 

In case you want to display parameters throughout the calculation area, the interior-

solid surface is selected. 

 
Figure 2.22 – Displaying the Contours menu 

For a detailed study, in a particular section of the model, you can create an 

auxiliary plane on any selected axis. For this, the following actions are performed: 

GM: Surface → Iso-Surface ... 

In the window that appears (Figure 2.23) in the Surface of Constant field, Mesh 

and Z-Coordinate are selected. 

In this field, you can enter the name of the new Surface Name. In this case, it 

remains the default. 

Enter the coordinates of the section in which the study is carried out, for example 

Z = 0 for Iso-Values (Iso-Value). 
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Figure 2.23 – Creating an auxiliary plane (Iso-Surface) 

Then the Create button is pressed. 

Similarly, other section planes are created (Figure 2.24–2.26). 

 
Figure 2.24 – Distribution of temperature fields in the longitudinal section of the 

heat exchanger 
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Figure 2.25 – Distribution of velocity fields in the cross section of the heat 

exchanger 
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Figure 2.26 – Distribution of temperature fields in the longitudinal section of the 

heat exchanger fin 
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Conclusion 
 

Based on the results of the work done, the following conclusions can be drawn: 

1. High informative results of numerical simulation contribute to a deeper analysis 

of heat transfer processes. 

2. Simulation of the gas-dynamic flow structure of the turbulence model makes it 

possible to obtain the distributions of the basic thermodynamic parameters in the flow 

of the heated ball. 
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